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Chapter 1. Getting Started 

Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, Technology 

files and any other data files before proceeding with the installation of the new version. The installer 

should not overwrite any of your own named files, but it can re-install new copies of our standard 

data files so if you have changed any of those files it is important to back them up first. If you are 

uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 

during design. 

Installation from a download link 

A download link for the installation of Easy-PC would have been provided to you by email. Click on 

the link to download the executable named EasyPC.exe. This is the whole installation set and should 

be saved and backed up for future use. Any subsequent patches can be installed on top of this ‘base’ 

setup once installed. 

Using Windows Explorer, find the executable in your Downloads folder and double-click it. You’ll 

need to type (or copy/paste) the password provided to unpack this file. Once the unpack password has 

been successful, you will be allowed to continue with the installation. You will also need to have your 

16-digit installation code to fully install the product. 

All other instructions should be followed until you click Finish to complete the installation. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 

latest version can install the new software over an existing installation without deleting the old one 

first. 

Installation From CD 

Insert the CD-ROM and wait a short time. The CD-ROM will run up to speed and an Easy-PC 

Welcome screen will appear. If autorun has been disabled on your computer you must execute the 

'setup.exe' program using the Start menu and Run command from the Windows task bar. 

With the installer running, once the Welcome screen is displayed, double-click on the Install Easy-

PC - Version 24.0 option, or click then press Run. Following the instructions on the screen, you 

should use the same Destination Folder for the Program Files as your existing Easy-PC program 

files. 

All other instructions should be followed until you click Finish to complete the installation. 

Note: CDs are no longer supplied by default, a download link would have been supplied to you to use 

unless you have purchased the CD media. 

Installing over existing Easy-PC software 

If you already have an earlier version of Easy-PC installed on your system and you wish to install the 

new version into the same folder as the earlier one, please note that you will then end up with both 

versions listed in the Windows Control Panel list of installed applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-install that 

version before you install the new one. If you install the new software into the same folder as the old 

version then try to un-install the old one, you will find that the new software will not run as the un-

install will have removed many or all of the program files. 
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If you wish to install and use the new version without removing the old one, you will need to install 

the new version into a different folder. The two versions will then operate independently and either 

can be un-installed without preventing the other from running. 

Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 

example, Libraries, Technology files, etc). The default is always to use the common documents 

folder, “Users\Public\Documents\Easy-PC” on Windows 7, 8 or 10 (or the local language 

equivalents) if you are installing for All Users, or into your own Documents folder if installing for 

current user only. 

Running Easy-PC 24.0 

Once installed, an icon will appear in the Number One Systems folder and the Start pane if using 

Windows 10, you may also wish to create an Easy-PC Shortcut icon on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems folder or the 

Start pane if using Windows 10. 
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Chapter 2. New Features in Easy-PC V24 

Introduction 

All features are categorised as being applicable to Schematic (SCM), PCB, or more general use 

(unmarked). 

File Open 

A new File Open dialog that provides access to recent Projects, Designs and Library items has 

been added. This can also be optionally changed back to the standard Open dialog using Preferences 

if required (see below). 

 

By using the Ctrl key, you can select or deselect more than one file at a time to open. 

Once the file required is selected and press the Open button. 

The Browse button will enable you to call up the standard Open dialog to search for your required 

design file. 

‘Pinning’ items in the list 

This new dialog includes the ability to ‘pin’ favourite items to the top of the list. This can be done by 

either clicking on the small pin next to the item name or by selecting the item once and right clicking 

to reveal the context menu. 
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On selection, the pin changes from unpinned to pinned: 

 

As well as Unpinning this item from the list, the context menu also enables you to Remove the item 

from the list (remember, the list is all recently used not a whole list of design items). There's no 

maximum number of entries for this feature, so it's up to you to remove any files that are no longer 

relevant. Use the Remove from list option on the context menu to do this. 

 

Disabling this option  

If you wish to disable this option and just use the standard dialog, uncheck the option Use Recent 

Files version of the Open dialog check box in Preferences and General.  
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Recent Files Lists Projects 

The Recent Files menu on the main File menu now lists Projects and Design files separately for ease 

of access. 

 

Add to Project – Other Files Relative Path Name 

When using Add to Project, there is an option to reference ‘other’ files (not PCB or SCM) using 

their relative path if they are in the same folder as, or a folder below the Project. 

When adding other types of files to a Project, once a file is selected to add, a new dialog will show the 

list of files and allow you to add them in one go by selecting the ones you require using the Ctrl key 

and select.  

You can also Copy the selected file(s) to the project folder or reference them using the relative path 

where relevant. This is instead of prompting you for each file as it is added to the project. 

 

Context menu for Relative Path 

Once in the Project file list, if the file lives somewhere relative to the Project file (in the same folder 

or below the Project), a new right-click context menu option will detect that the indicated file is below 

the Project and will allow you to convert their full absolute path into a Relative Path. 



10   Easy-PC V24.0 Supplement 

 

Once converted, if selected again using the context menu, you can return to the Absolute Path if 

required using the option that is now displayed. 

Save Project to Zip File 

There is a new command on the File menu of a Project, that saves all the files in a project into a 

single Zip file for ease of archiving or sending to colleagues, etc. 

When selected, the Save As dialog is displayed where you can choose the folder to save the Zip file 

into. By default, it displays the current Project folder for saving. 

 

Intelligent Design Backup Interval 

Design Backups (if enabled) are written whenever you save a Schematic or PCB design. Using the 

new Work Time controls (enabled by default) the application will ensure that a meaningful amount 

of work is done between each backup regardless of how frequently you Save the design on which you 

are working. This means you can Save as often as you like without “filling up” your set of cyclic 

design backups with tiny incremental differences. 

Two new settings on the Preferences, General dialog allow you to define the amount of work time 

has to elapse before making the next backup (Min work time between backups), and how long the 

design has to be unmodified before it is considered idle and thus the work timer stops ticking over 

(Idle time before stopping work). Work Time is triggered by any design editing that records or 

invokes an Undo action. 
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BOM Composer Update 

Sort Values on columns 

When sorting on the Values column it will now work out the actual electrical value and sort by that, 

smallest to largest. It does not understand exponents, so values such as 10e-9 or 2.2e3 will not be 

sorted. 

Thus 6.8pF will come before 4.7nF. It also understands absolute values too, for example 100pF = 

0.1nF 

 



12   Easy-PC V24.0 Supplement 

New Line Item Number Field 

There is a new field available to add in BOM Composer that automatically writes a line item number 

for each row of data output to the report files. 

To access the Line Number feature, click on the green + plus button on the central navigation bar. 

 

From the Edit Column dialog displayed, select Line Number from the Type drop down list. You 

can also type your own Caption if you require one in the report. 

 

The Line Number caption then appears in the Columns, Group By and Sort By columns, ready for 

positioning. As with all column items, move them in the report using the Up and Down arrows. 
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A sample report might look like this: 

 

Cross-probe zoom After Probe 

There is a new check box on Cross Probe page of Preferences dialog to Auto Zoom when probing.  

 

This enables you to see what has actually been selected in the probe target. Previously, the default 

action was to pan the selected item into view if it is not already within the view. With this check box 

set (which is the default setting), the target design will zoom to show the selected item and a 

reasonable area around it.  

New Nets Bar 

A new dockable Nets Bar showing details of the nets in a PCB design has been added to Version 24, 

(note this is not available for Schematic Designs). The bar can display Net Name, Net Class, Total 

Track Length, Min/Max Length Values and Rules, Via Count and Test Land Count. These details 

are available already in the head-up display for a single track being edited, but the new bar allows you 

to view this information across multiple nets to assist with length matching etc. 

Access the Nets Bar from the View menu and Dockable Bars> Nets menu option. 
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There are various settings you can use to control what information is presented to you on the bar. The 

Options dialog is used to specify which nets to include in the table (for example by net class, net 

name or selection). The Columns dialog allows you to choose which of the available columns are 

displayed and in which order. 

Once you have the bar set up to display the columns and nets that you are interested in monitoring, 

you should see the information updated automatically as you make changes in the design itself such 

as routing tracks, changing layers or adding connections. 

For the Net Properties that are governed by rules on your Net Classes, the values in the bar may also 

be drawn with a coloured background to help you see which nets are within the rules (green) and 

which are outside (red). These colours can be changed using the Options button. 

The Options button is used to control the Nets that are displayed on the Nets bar: 

 

Choose from one of the available options to control which Nets are displayed. Empty (unused) nets 

are always excluded as they contain no useful information. 

Include 

• All Nets - every Net in the design. 

• Selected Net - only the Net to which the currently selected item belongs. 
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• Selected Net Class - all Nets that belong to the same Net Class as the net of the currently 

selected item. 

• Matched Nets - Nets whose name matches the filter or wildcard text given. 

• This Net - one specific Net. 

• This Net Class - Nets of one specific Net Class. 

In addition to this you can opt to include or exclude Nets by other properties. 

• Power/Ground Nets - those whose Net Class is of type Power or Ground. 

• Nets without length rules - those whose Net Class does not specify any min/max or length 

difference rules. 

• Default nets - those which have a default (not user-defined) name. 

Note that if you have opted to include a specific named net then these additional check boxes are 

ignored. 

Settings 

• Auto Scroll - checking this option will ensure that the net on which you are working is 

always kept in view in the table. 

• Valid Colour - this is the background colour for table cells that are within the specified 

highlight track lengths rules.  

• Invalid Colour - this is the background colour for table cells that are breaking the specified 

highlight track lengths rules. 

The Columns button enables the Edit Nets Bar Columns dialog. This is used to control which of the 

available Columns in the table you wish to see. 

 

Choosing Columns 

Use the buttons in the middle part of the dialog to manage the columns in your Nets bar table. 

Available Columns can be used by selecting them and pressing <<Add or simply double-clicking on 

the name. Likewise, to remove a column from the Current Columns list, double-click the name or use 

the Remove>> button. 

The Minimum button will re-initialise the list to display a minimal set of information. Similarly, the 

Full button will re-initialise the list to display all available columns. Using the Move Up and Move 

Down arrows enables you to position the columns as required in the grid 
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Columns Available 

These are the columns available for display: 

• Name - the name of the Net  

• Class - the name of the Net Class  

• Vias - the number of Vias in the Net  

• Test Lands - the number of nodes (Pads or Vias) in the Net that are marked as Test Lands  

• Pads - an abbreviated list of the component Pads  

• Net Length - the total length of the Net (see the note below for Net Length calculation)  

• Length Diff Rule - this is the Length Difference value if you have enabled this rule in Net 

Classes  

• Shortest In Class - the shortest Net length across the whole net class. 

• Longest In Class - the longest Net length across the whole net class. 

• Length Diff - the difference between the shortest and longest Net length across the whole net 

class. 

• Min Length Rule - the minimum length allowed for the Net as specified on the MinMax rule 

in Net Classes. 

• Max Length Rule - the maximum length allowed for the Net as specified on the MinMax 

rule in Net Classes. 

Net Length Calculation 

The calculation of Net Length displayed in the Nets bar uses the same settings for unrouted 

connections as the Headup Display, which you can find on the Display tab of the Preferences 

dialog. This allows you to control how the remaining unrouted connections affect the overall net 

length value. 

Net Nodes dialog 

Double-clicking on a ‘Pads’ cell in the bar will open a new dialog allowing you to explore the pads on 

that net in more detail including being able to see the nets attached to all pads of a given component. 
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Information about the net is shown in the left-hand part of this dialog. This includes the name and 

class of the net, and a full list of all the 'named' nodes in that net (i.e. leaving out unnamed items such 

as junctions or vias).  

Click on any node in the net to display information about the whole component to which that node 

belongs. This includes the component name and reference name, as well as a complete list of the nets 

connected to all the pads of that component.  

Double-click on any of the pads shown for the component (or select one and click the < button) and 

the attached net will become the 'current' net and the dialog will update to show information about 

that net.  

You can use the Back and Forward buttons to move through the various nets you have inspected.  

The dialog can be resized to allow you to view longer names.  

Net Properties – Nets shown on other sheets 

With a selected net, Net Properties has been extended in a multi-sheet project to include Pads on 

other sheets, these are shown with an asterisk suffix to differentiate them. 

 

Goto Bar shows DRC Errors for all Open SCM Sheets 

In a multi-sheet Project, the Goto Bar now shows DRC errors for all open SCM sheets. 



18   Easy-PC V24.0 Supplement 

Different sections for each page are shown: 

 

New Disconnect From Signal Nets option 

Available in both Schematic and PCB designs, a new context menu option Disconnect from Signal 

Nets can be used in select mode. As the name suggests, this will do the same as Disconnect From Net 

but it will only do it to nets whose net class is of type Signal, thus leaving any power/ground nets still 

connected. 

This option is useful if you need to swap gates for instance in a Schematic, it means that the power 

and ground nets are still connected without having to remember to connect them after the gate 

changes have been made. 

Accessing it in Schematics 

To access this new mode in the Schematic, select the Component and right click. From the context 

menu select Disconnect from Signal Nets. 

 

Once the option is selected, the Component is disconnected and you can move or remove with the 

connections remaining in place ready for welding back in. 

Accessing it in PCB 

In PCB, this option is accessed through the Nets sub-menu for a selected Component. 
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The option works for both routed and unrouted Components in PCB. 

Changes to Component Values dialog 

Editable Ref Name Column 

On the Component Values dialog for a design or Project, the Ref Name column is now editable. 

This allows you to alter the names of multiple components in one place. To edit a name, double click 

on the Ref Name cell and type the name required. On exit of this dialog, the name will be checked for 

validity. 

 

Note, if you make changes in this dialog in a PCB design, these will also be recorded for back 

annotation to the schematic 

Component Values dialog sorting 

Clicking on the column header for any column that is one of the recognised “value” names (Value, R, 

C, L etc.) will now sort on the ‘actual’ value taking into account series/numeric prefixes, thus putting 

100pF before 100nF. It does not understand exponents, so values such as 10e-9 or 2.2e3 will not be 

sorted. 
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Ref Name Filter 

A field for Ref Name has also been added to the Filter controls, allowing you to filter the component 

table based on a wildcard of component ref names. 

 

Colouring for Read-only Controls 

Read-only edit boxes now have greyed background to make it clear that they are not currently 

editable. 
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Drag Connected Items to Component Bin 

Dragging items to the Component Bin has now been extended to allow you to drag components to 

the bin even if other design items, like Connections or Tracks, are also in the selection. Previously, 

moving connected items to the bin was only possible using Move To Bin. The bin must be pinned for 

this option to work. 

Rules for Colouring Components 

A new Component Colours tab is available in both the Design Technology dialog and Display 

(Colours) dialog to allow settings for over-riding the colours used to draw Component shapes and/or 

text. 

Match components by wildcard on chosen property/attribute and specify colours to be used for 

matching components by side/layer. This can be used for things like producing a colour-coded 

assembly drawing, highlighting components with an ‘obsolete’ value, etc. 

 

The Design Technology dialog reflects the same colours as Display: 

 

Using the Add button displays the Component Colour dialog: 

 

Applies To: is used to select the item the colour applies to, choose All, Shape or Text. 
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Layer: choose the layer that the colour is applied to. This can be any layer in the design. 

Include Swap Layer will automatically do the same colouring on the equivalent layer on the bottom 

side as you've set on the top. When set to No, the colour you've defined will only apply to the layer 

you have chosen 

Colour: choose the alternative colour required for the item. 

Match Criteria: match based on a Value Name, for example [Reference Name]. The Matches: can 

be specific names or wildcard names. 

Move Components Names within a Tight Group 

If you select one or more Component Names (and nothing else) where those Components are part of 

a tight group, this allows you to move those names without disturbing the position of the 

Components. 

New Preference – ‘Allow Move Names in Tight Group’ 

Under Preferences and Move in both SCM Interaction and PCB Interaction, there a new check 

box, Allow Move Names in Tight Group to use when dragging Component Names (as described 

above). 

SCM Interaction dialog 

 

PCB Interaction dialog 
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Changes to Change Component & Replace Component 

Changes have been made to the Change Component dialog (from Component Properties) and 

Replace Component (from Tools menu): 

Change & Replace Component dialogs are now resizable 

You can resize the dialog by grabbing the edges or corner of the dialog and dragging it. This is useful 

if you have large components that cannot be viewed using the default size. 

Values are shown in the Preview list 

 

The preview for the selected Component shows you Values. This is the same as it does already in the 

Add Component dialog. 

 

Check box to “Keep Local Values” 

Once run with the chosen new Component, the choices dialog now enables you to Keep Local 

Values. This will ensure that any values you have defined or altered locally on the Component 

instance in the design will be retained when the new Component definition is applied.  
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Rename Components by List 

The Rename Components option (on the Tools menu) has been extended to allow you to provide a 

list of new Component Names (including name ranges) that are used in the point-and-click stage 

instead of simply renaming sequentially. As well as typing the list, you can also import a list using 

Copy/Paste. 

 

When all the names have been “used up”, you will be asked if you want to name some more, pressing 

Yes will return to the dialog for you to enter more names. 
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Changes to the New Component Wizard 

Description box 

The Details tab of the New Component Wizard now has Description box from which to enter the 

Component description. 

 

Values Tab 

The New Component Wizard now has a new tab for Values to allow you to add values to the 

Component you are building. 

 

Library Item time stamps 

When copying items between libraries, or from designs to libraries, the existing time stamp 

(‘version’) on those library items will now be preserved rather than set to the current time. This helps 

with getting the correct comparison of library items when running options such as Update 

Component regardless of any library item re-arrangement that has been done. 

Prompt for Net Name on Add Connection 

When starting a new Connection, the new Add Net option will display a net name dialog allowing 

you to supply a name straight away, instead of having to finish the connection and/or do Change Net. 

This is a switchable option and is on by default. It can be switched off in Preferences, see below. 
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The dialog will auto-increment if possible, to assist with adding a series of net with sequential names. 

If you used ADD1 as your net name for example, using Add Net a second time will increment the net 

name to ADD2. 

Preference to switch off prompt 

If you do not want to be prompted for a Net Name, you can switch it off using Preferences and 

Schematics Interaction and PCB Interaction and unchecking the Prompt for new Net Name box. 

Schematic Interaction tab 

 

PCB Interaction tab 

 

Design Rules Check Changes 

Component-to-Component SMT Check 

When doing a Component-to-Component check for SMT components on the opposite side of the 

board against a through-hole component, if no placement shapes are defined for the through-hole 

component’s bottom side then Spacing checks are now done only against the space occupied by the 

pins protruding through that side of the board, rather than using the bounds of the entire component 

on that side. 
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In the diagram left, the C17 SM component is on the 

bottom side, the connector PL3 is through-hole. C17 has 

no placement area and as such can be placed closer to the 

pins of PL3 on the bottom side. If PL3 has a bottom side 

placement area, then this would be used for the spacing 

rule. 

 

Include Integrity Check 

Integrity Check is now available within the Design Rules Check dialog. It's presence here allows it 

to be included in your saved Sign-off checks. 
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Check for Unpoured Areas 

There is a new check under the Manufacturing header that checks for Copper Pour Areas that have 

no copper attached to them (Unpoured Areas). This is an important check to ensure full design and 

electrical integrity within your design before sending away for manufacture. 

 

Silkscreen Overlap Check 

The existing Silkscreen Overlap check has been split into separate checks for Shapes and Text. 

 

Individual Item Selection in Silkscreen Checks 

Further extensions to DRC Silkscreen Overlap checks means you can now split them by checking 

Shapes and/or text against any of Board, Pads, Free Pads, Vias and Text.  
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Min Via Hole Size 

There is now a separate value on the Design Technology, Rules for Min Via Hole Size so you can 

have two different values for the minimum hole size used for Vias as well as Pads (using Min Hole 

Size option). 

 

Integrity Check suppress PCB-only 

The is a new setting in the Integrity Check section of General Preferences. With the Warn 

SCM/PCB only check box unchecked, any warning messages about ignoring SCM-only or PCB-

only Components during Integrity Check will be suppressed. This means where there are many 

warnings that you know to be correct and irrelevant to you will not be written to the report, thus 

decluttering it. 
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Change to Preferences for ‘Cancel in Add Track’ 

The existing preference for Cancel in Add Track returns to Select Mode has now moved to the 

Interaction tab of Preferences dialog (it was previously on the PCB Tracks tab). This makes it more 

meaningful as it applies to other options (see below). 

 

Applies to other items too 

The Cancel in Add Track returns to Select Mode option has also been generalised to apply to Add 

Track, Add Connection, Add Shape, Add Line and Add Text. 

Paste Shapes in Footprints  

Within the PCB Symbol (Footprint) editor, in the Tools menu there is a new command, Apply 

Paste. This is used to assist in creating a rectangular pattern of paste shapes for items such as thermal 

pads. This is an automated way to create something you can already do by hand but this tool makes it 

much easier. 

For example, it can be used to add a 4x4 Paste layer cutout matrix to the central thermal pad. A 

practical example Component using thermal cutouts shapes is the NXP device MC34GD3000EP 

using the QFN50P800X800X100-57N-D footprint. It helps you create the shape sizes, position them, 

add quantities, create the gaps etc. The dialog lets you create the shapes based on manufacturer’s 

datasheets and also lets you do this iteratively by trial and error. Each time a value is altered, it can be 

applied to the shapes to enable you to see what has been created. 

Paste defined on the paste layer will reflow during manufacture to cover the whole thermal pad. You 

must also have a paste layer in your design for this to become useful. 

 

Select a single pad in your PCB symbol to enable this command on the Tools menu. The pad selected 

will be the one that the shapes are applied to. A dialog will be displayed allowing you to control the 
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pattern of shapes to be created. Existing shapes can also be removed, allowing you to easily try 

several patterns until you are happy with the result. 

The top portion of the dialog shows you the Pad Style you have selected; it shows you the Pad Style 

Name and the actual style used. 

 

Shape Details 

Choose the Layer on which the shapes are to be created, and the Line Style to be used for those 

shapes. A narrower line style will produce smaller rounded corners on each shape. You’ll probably 

find that you’ll need a very fine line style because of the size of the shapes. You’ll need to add one if 

it doesn’t already exist in your Design Technology Line Styles. 

Enter the Width and Height for an individual paste shape. You can also choose to define the Width 

and Height based on the Centre Line of the shape, or by Outside Edges when the application will 

work out the position of the shape segments for you. The options you choose may depend on what 

information is provided on the datasheet for the component you are building.  

Arrangement 

Use the controls in this portion of the dialog to define how the paste shapes are going to be arranged 

over your pad. 

Gap allows you to define the gap between adjacent edges of shapes, whereas Step allows you to 

specify the distance between the same point (e.g. lower left corner) of each shape. 

Fill Pad will allow the application to work out how many shapes are required to match the Width, 

Height and Gap/Step you have defined, whereas Count allows you to specify an actual number of 

shapes in each direction. 

The tool will discard any shapes that are not entirely within the confines of the pad, even if you 

specify too many shapes or too large a size. 
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Settings 

Remove Existing Shapes will delete any shapes that already exist within the pad on the chosen layer. 

This is useful when trying out various patterns, as it will discard the previous pattern before creating 

the new shapes. 

Apply Pad Style Exception will create a "by layer" pad style exception for the pad over which you 

are placing paste shapes, to suppress the application-generated solder paste that would normally 

happen during plotting and printing. You should not enable this setting if there are other pads in your 

PCB Symbol that use the same pad style, otherwise no paste may be generated for those pads. This is 

not generally an issue, as you would almost certainly be generating paste shapes for a large central 

pad that is the only one using that pad style. 

Mirror Pad Style Exceptions 

A new check box Mirror with Component on the Design Technology Rules page has been added. 

With the Mirror with Component check box selected, when a Component is flipped (mirrored), it 

flips over the pad style stack so that any pad style exceptions are applied to the swap layer 

automatically instead of having to define two sets of exceptions for the Top and Bottom layers. 

 

This setting applies to the whole design, so care should be taken when checking the box in an existing 

design to make sure that any existing pad style exceptions are still working as expected. 
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Allow Reposition of Component Pads 

An additional check box on Pad Properties called Allow Reposition has been added. When this is 

checked, the pad on this instance of the Component can be independently moved or rotated, either on 

the Properties dialog or interactively. 

 

Options for Drawing Connections by Side in PCB 

In a PCB design on the View menu and Net Connections, new commands are available to set 

connections to be drawn only on one side (e.g. only those between Components on the Top Side) and 

only when both ends are within the current view. 

 

This only applies to the pads to which the connection is applied. The connection itself remains 

independent of any specific layer as normal. 
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Pour Copper Avoid Same Net Tracks Setting 

A new check box has been added to Copper Pour Area Properties to Avoid Same Net Tracks. 

When checked, this will instruct Pour to treat all tracks, even those on the same net as the Area, as 

obstacles to avoid. 

 

Examples of pouring below: 

Without this setting With this setting 
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Thermal Spoke values by Pad Style 

In the PCB Design Technology, Pad Styles now have an extra field for Thermal Spoke Width. If 

this value is set to something greater than zero (the default) then this size will be used in preference to 

any design, or area-level rules defining thermal spoke width (in Design Settings, Rules). 

This allows you to override the normal size of thermals for larger pads to ensure a better dispersal of 

heat from the pad during soldering. 

 

The Thermal Spoke value is now also displayed in the Design Technology Pad Styles dialog for 

ease of checking. 
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Plot Include/Omit Drilled-out Pads 

An additional check box on the Settings tab of the Plotting & Printing dialog has been added.  

If you have pad styles where the drill size is larger than the pad, this produces an effect called 'drilled 

out pads' where any copper land for the pad would be completely removed by the drilling process. If 

you want to suppress the pad land from these drilled out pads, then uncheck this check box. 

 

Output Drill Data to Gerber 

Drill data plots, previously only written to Excellon format, can now write in Gerber format as well. 

This means drill data can be exported using Gerber X2 format as required by some manufacturers. 

From the Output tab of the Plotting & Printing dialog, with Gerber selected using the Plot Type 

drop down list, select the new option, Drill Data. This applies to new plots as well as existing plots. 
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Extra header info in Excellon 

Excellon files can now contain extra header information to specify coordinate formatting and file 

contents, including file function and other details compatible with the Gerber X2 standard as advised 

by Ucamco. 

Gerber Viewer embedded in NumberOne.com Web Site 

In partnership with Ucamco, the owners of the Gerber format, you now have access to the Gerber 

viewer tool embedded within the NumberOne.com web site. This viewer can be reached at 

https://www.numberone.com/gerberviewer.asp  

This is an important verification tool as it allows you to preview your Gerber files before you send 

them out for manufacturer. 

To use this tool, simply drop your Gerber files or collection of Gerber files in a ZIP file onto the web 

site where they will be opened to view. 
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ODB++ IP Protection 

Three new options are available on the Export ODB++ dialog that help with protecting your 

intellectual property (IP) whilst still allowing manufacturing data to be produced and sent externally 

to your company. 

 

Neutral Names: net and Component (part) names are replaced with plain sequential names. 

Omit EDA: leaves out the ‘EDA’ and Parts list (BOM) sections of the data. 

Omit Netlist: leaves out the ‘cad netlist’ section so no net names are available. 

Layers Bar - Hide Power Plane 

In the Layers Bar, when double-clicking on a Power Plane layer to make only that layer visible, any 

currently displayed power plane will be turned off. This equates to automatically using the Hide 

Powerplane option when displaying a single layer. 
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Layers Bar - Toggle True Width with Ctrl Key 

In Layers bar, if you single Ctrl-Click on the layer name, it will toggle the true size state on that 

layer (e.g. Tracks and Copper shapes). 

 

With true size on Without true size on 

  

Named Layer Toggles 

The Layer Toggle entries now have an optional Name. Access this by right-clicking on the Layers 

Bar, Set Toggle Layers. 

 

Those that are named will be listed on the Layers Bar below the actual layers. This allows the 

toggles to be enacted from there without having to be assigned to shortcut keys. Toggle entries are 

indicated by the “on-off” icon alongside their name: 

  

To action a layer toggle, either click the check box (which will momentarily show as checked then 

uncheck itself again) or double-click on the name. 
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Footprint check – Copper to Pad Association 

When saving a PCB Symbol any copper shapes assigned to pads will be checked to make sure that 

their associated pad is actually inside the shape. If they aren’t, a warning dialog is displayed: 

 

Hexagonal Pad Shapes 

A regular hexagon shape has been added to the list of available Pad Shapes available. This can be 

used in both the PCB and Schematic editors. 

  

Highlight Net during Add and Edit Track 

When adding or editing a PCB Track, PCB Connection or SCM Connection, new Preferences will 

automatically highlight the net being edited to make it easy to see the rest of the items on the net. 

Preferences, PCB Tracks page: 
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Preferences, Schematics Interaction page: 

 

Clear Highlight After Edit option 

As well as the ability to highlight during edit, there is also a new complementary option called Clear 

Highlight After Edit that when checked, will remove the highlight once editing is finished. 

 

Prefer Visible Layer in Add and Edit Track 

When adding or editing a PCB track, if the expected/default layer is not visible, checking the Prefer 

adding on visible Layer option (set in Preferences, PCB Tracks) will use the first visible electrical 

layer instead of attempting to make the hidden default layer visible. 
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Move Treat Vias as Fixed 

When moving PCB track segments, the Treat Vias as fixed on move Track option causes unselected 

vias at track ends to be treated as fixed, instead of picking them up with the moving tracks. This 

avoids disturbing track patterns on other layers. 

This option can be accessed from Preferences on the PCB Interaction page: 

 

 


